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Application General Information 
Pain Distribution is an application that automatically calculates the number of the pixels the patient has 

chosen and therefore quantifies the pain extent, provides the frequency distribution from a group of 

images, and has the option to select the threshold over which the patient is considered with central 

sensitization (CS). Additionally, it delivers results and statistics for both every image and the frequency 

distribution, providing mean values, standard deviations, and CS indicators, as well as the ability to 

export them in *.txt file format for further analysis. 

Installation 
Windows Users: Download the application, run the installer and follow the instructions. 

MacOS Users     : The application is tested and runs without problems in MacOS by using the WhineHQ 

emulator. 

The User Interface 

 

1. The Menu  

2. The Toolbar 

3. The original image 

4. The processed image 

Note: At the 1.1.0 version of the software the “Compare two files”  has been 

added in File Menu as well as on the toolbar. 

https://www.winehq.org/
https://www.winehq.org/
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1. The Menu  
The menu bar contains all the commands of the program. Specifically:  

The File (contains Important Reading!) 

 

• Open File… : Opens and process one image.  

• Open Folder… : Opens a folder with images and process all of them at once. 

• Export Reference Image : Exports the reference image used as template by the application. 

Important Reading: The Pain Distribution application, in order to automate its calculations, uses 

a standard reference image (template) and no other image should be used by the users.  

Go File>Export Reference Image and save the template (Reference.png) on your disk. Transfer 

the template image on your tablet and use it with your sketching application of choice (there 

are plenty of them online given for free). After the patients have sketched the pain areas on the 

reference image with a color pen (with any color other than black or-obviously- white), transfer 

the images from the tablet to your Pain Distribution application for processing. 

The creation of the reference image (template) was a complicated task: had to be in HD (many 

pixels), the front and back figure areas being of the same size, had to provide easy recognizable 
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body parts, had to deliver most of the body areas for sketching, had to be genderless, and many 

other complicated technical demands (see Application Errors, page 12). 

 

The above is the reference image and it was created by the professional Illustrator Thodoris 

Tibilis.  

The Edit  

 

Go Edit>Copy to copy the Processed Image on your clipboard for transferring. Should the user needs 

both images, original and processed, can use PrntScr and crop the area of interest by using a windows 

build-in app like Paint. 

http://www.tibilis.com/
http://www.tibilis.com/
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The View  

 

• Toolbars and Docking Windows : Use Standard or Customize the docking of the application’s 

Toolbars. 

• Status Bar : Use or not a Status Bar at the bottom of the application. 

• Application Look : Change how the application looks according to your taste. 

• Results : Delivers the processing results. As it is necessary to explain how the application works 

first, the Results are discussed latter (see page 9). 

 

The Options (contains Important Reading!) 

 

• Use Smart Selected Area Calculations :  The Pain Distribution application has calculated the 

number of the pixels of the whole-body areas and compares this number with the number of 

the pixels the patient has chosen with the color pen. Then, it creates a processed image at the 

right side of the original one (see User Interface 3 and 4 at page 2).  
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By default, the application excludes all the colored pixels selected by the patients that 

happened to exceed the boundaries of the body chart and uses for the calculations only the 

ones that are inside the body-chart areas. In order to provide visual inspection and proof,  the 

pixels used by the application for the calculations are showed in the Processed Image by the 

complementary of the color  used by the patients, while the pixels not included in the 

calculations are left in their original color, as it is shown below. 

 

 

 

 

 

 

 

 

 

Occasionally, some patients leave uncolored some areas that we are sure they intended to be 

colored, like these small white areas inside the colored areas shown below. Notice that in the 

processed image at the right, these white areas inside the colored selected areas are not 

included in the calculations. 
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By selecting the “Use Smart Selected Area Calculations” option these areas are covered with 

color and take part in the calculations, as it is shown below.  

 

 

 

 

 

 

 

 

 

 

 

               Original Image             Processed without “Use Smart                Processed with “Use Smart 

                                       Selected Area Calculations” option            Selected Area Calculations” 
option 
 
 
Notice that when the Use Smart Selected Area Calculations option is chosen, the color of the 

calculated area changes to pink. Therefore, users are advised to avoid using the pink color on 

the pen. However, although the instruction of avoiding black or white pen color is strict, for the 

pink color is not: the processed image may not be visually correct, but all the calculations will be 

done in a valid way. 

Important Reading:  

There will be cases where the patients intentionally leave an area uncolored, 

like in the example on the left. In these cases, the Use Smart Selected Area 

Calculations option should not be used. 

 

Users are advised to inspect all the images before they use this option in 

order to avoid erroneous calculations. 
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• Enable Probe Tool : This tool provides the Frequency Distribution image, like below. 

 

In order to use this tool, a folder of images should be selected (see Open Folder, page 3). The 

Frequency Distribution image explains the frequencies in a color bar, while at the top left informs 

the user about the Maximum Frequency.  By placing the mouse cursor on the colored area, 

frequency information of that specific point is provided, like below. 

 

 This information comes in a form of x/y (z%), where x stands 

for   the number of images that have been colored at the 

selected point, y stands for the total number of images and z 

stands for the percentage of the x over y. 
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• Set CS Threshold… : Prior to any calculation, the user should select the threshold over which the 

patient is considered with CS. When this option is selected, a dialog box like below appears. 

 

The application uses a dummy number of 16%, but the user 

should use the number recommended from the bibliography or 

the scientific research papers, or he could simply use his own 

number to test an idea. 

 

 

 

The Help 

Delivers information about the contributors, the copyright, provides contact information and opens the 

present application guide. 

 

2. The Toolbar 
The toolbar provides shortcut buttons for the most useful commands of the program, as it is shown 

below. 

 

The above icons, from left to right, stands for Open File, Open Folder, Use Smart Selected Area 

Calculations (see page 5), Enable Probe Tool (see page 8) , Results and the “About the Application”. 

 

The Results 

The results are shown either by selecting the above toolbar icon or from the Menu bar, by selecting 

View>Results. When selected, the following dialog box appears: 
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At the top, information about the CS Threshold chosen by the user (see page 9) is provided. All the 

following calculations use this CS Threshold. 

Next, is a table with four columns: the first is the number of the image, the second is the image name, 

the third is the Ratio (%) of the colored area in relation to the total body area (frontal + back), and the 

fourth column is the CS indicator (true or false) according the chosen CS Threshold. Notice that the CS 

incidence is colored red. 

Below that table, more detailed information is given about the mean ratio (with SDs) of the whole image 

set, the CS image set and the non-CS image set. 

The Frequency Distribution numbers deliver information about how many images have common colored 

areas in the whole image set, in the CS image set, or in the non-CS image set. 

At the bottom right of the dialog box, the user can export the above information in a *.txt file for any 

further processing in the Microsoft Excel or any statistical software. 
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3. The Original Image 

 The original image is the image that comes from the tablet and is colored by the patient. At the top left 

the image name and number are given. 

 

 

To scroll between images, use the left-right keyboard arrows or the mouse wheel. 

 

4. The Processed Image 

The processed image comes in two forms: a) the processed original image, and b) the frequency 

distribution image. 

A. The Processed original image always shows the results of the original image being on the left 

side of the application. At the top left, information about the whole-body pixels, the selected 

(colored) pixels, the ratio between them, and a possible CS indicator (according to the Threshold 

chosen by the user) is given. 

  

 

B. The Frequency Distribution image is shown when the Probe Tool is enabled (see page 8) and 

provides information about the Maximum Frequency at the top left. 
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5. File Comparison (in 1.1.0 version of the Software) 

In order to fulfill “Reliability Test” needs of the scientific community, the new   

tool has been added at 1.1.0 version of the software.  The tool provides information (in pixels and 

percentages) regarding the common and uncommon drawn areas between any two images, as it is 

shown below: 
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Application Errors 
All possible sources of application errors have been investigated thoroughly, and specifically: 

1. Validity 
• The calculations are valid: the application measures exactly what the patient has colored, and 

only inside the body shape. 

• Validity errors coming from any discrepancies between the area the patient colors as painful and 

the true painful area are not considered as application’s errors. 

2. Reliability 
• The application is reliable, as it uses the same code methods in any repeated calculation. 

3. Reference image errors 
• The frontal and back side of the image have the same number of pixels: 758518 each side. 

 

• The reference image has been drawn without antialiasing, meaning that they have as less gray 

tones as possible, and therefore the boundaries of the body shape are recognized without 

significant errors coming from a gray color area (error of a few pixels on an 1,5m pixels image). 

• All the inside-the-body black lines help the patient to recognize his pain areas but have been 

excluded from the calculations, meaning that even if the patient colors the black line of the 

scapula, for example, this area is included in the calculations. 

Some researches (or clinicians) may want the reference image to follow the rule of nines for burn. 

Although this issue cannot be considered as an error, the examination of the reference image 

provided the following results: 

A. Upper extremity: 78253pixels/1517036pixels = 5.16%. The Frontal Upper Extremity area 

over the total body area should be 4.5%. Difference 0.7%. 

 

B. Torso: 250803pixels/1517036pixels = 16.5%. The frontal torso area over the total body area 

should be 18%. Difference 1.5%. 
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C. Lower Extremity: 157704pixels/1517036pixels = 10.4%. The frontal lower extremity area 

over the total body area should be 9%. Difference 1.4%. 

 

D. Head: 48409pixels/1517036pixels = 3.2%. Head and neck together should be 4.5%, and neck 

is considered 0.5%. Therefore, we have a difference of 0.8%. 

 

Summarizing the above results, there is a mean of 1.1% (SE 0.2%, range 0.7%-1.5%) difference on each 

body side, and double [mean 2.2% (SE 0.4%, range 1.4%-3%)] for the whole body (as we have the same 

frontal and back number of pixels). 

The maximum difference of 3% that exists between the sketched body shape and the rule of nines for 

burn is small; this difference can be considered as an error coming from the points defining the lines 

that set the boundary between each body part, and therefore, we believe that the reference image 

follows the aforementioned rule. 

License 
The Pain Distribution application and its reference image are free for any use by mentioning the 

contributors. In case of use in research/academic, citing the following paper which regards the 

application would be highly appreciated: 

Kanellopoulos A K, Kanellopoulos E K, Dimitriadis Z, Strimpakos N S, Koufogianni A, Kellari A A, Poulis I A, 

(2021) Novel Software for Pain Drawing Analysis. Cureus 13(12): e.20422. doi:10.7759/cureus.20422 

[https://www.cureus.com/articles/77401-novel-software-for-pain-drawing-analysis#!/] 

https://www.cureus.com/articles/77401-novel-software-for-pain-drawing-analysis#!/
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Contact Information 

For any bugs, suggestions, questions or other information please contact: 

Dr Asimakis K. Kanellopoulos 
BSc (Hons) in Physiotherapy 
MSc (Distinction) in Bioengineering 
PhD in Biomechanics 
Assistant Professor, Department of Physiotherapy, Health Assessment and Quality of Life Lab, University 
of Thessaly, Greece.   
akanellopoulos@uth.gr  

Please, on the email subject, write: Pain Distribution Application 

mailto:akanellopoulos@uth.gr

